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MortgageBrain Classic v2.2 Release Notes 
 

MortgageBrain Classic v2.2 contains a number of enhancements to meet the requirements laid out 

within the GDPR rules. The enhancements within the software are detailed below. The GDPR 

guidelines are provided at the end of this document. 

General Data Protection Regulation (GDPR), which replaces the current Data Protection Act 1998, 

comes into force on 25th May 2018. Any organisation that collects and stores client data will need to 

adhere to the new regulations, with substantial fines applied for those companies who do not have 

the correct processes and procedures in place. 

 

GDPR enhancements within MortgageBrain Classic 
MortgageBrain Classic stores client data on your desktop/laptop. The information is contained within 

files within the MBL directory on your hard drive.  

As part of the GDPR guidelines, it is necessary for you to hold client data on your PCs or laptops 

securely. 

On installation of v2.2, the software will create an encrypted backup of your existing client data and 

will ask you to enter a password, as shown below, to encrypt the backup. Please make a note of this 

password as this is unique to yourself and, therefore, Mortgage Brain cannot send you a reminder of 

what it is in the event that you need to use it. 
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Then the software will examine the existing client data records, remove any that are no longer 

necessary and ensure that the remaining data is secure and protected. 
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Client Database 
The majority of changes for GDPR are contained within the Client Database on MortgageBrain 

Classic. The client database is found by accessing it from the Launch screen, as shown. 

 

When entering the client database, six buttons are displayed. Select Enter New Client Details or 

Display Current Client Details to open the database.  
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The View menu, shown below, displays the features that have been included to address the number 

of GDPR requirements. 
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List dormant clients 
GDPR requires you to justify why you are keeping client data, and if it is not required then it should be 

removed. Therefore, if you have clients in your database that you have not contacted for a number of 

years and there is no clear reason as to why you are holding their data, then it is important that you 

review these clients and delete them or contact them, whichever is most appropriate. 

  

When selecting the Dormant Client List option, there are a number of search facilities that you can 

carry out as shown in the dialogue box below.   
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Having entered the search criteria, the clients that match, are listed. Clients that you no longer wish 

to keep records of can be deleted individually or altogether.   

 

Delete Clients 
When selecting the Delete button, shown above, the Delete function dialogue box (below) contains a 

variety of options for deletion, which are available when deleting individual clients and/or partners. 

However, when deleting clients via the Dormant Clients function, the only option is to delete all data 

from both applicants (where applicable), along with the ability to delete accompanying 

documentation as well. The assumption is that as the clients have been dormant for a period of time, 

and therefore there has been no recent activity, then there is no requirement to specify what needs 

to be deleted.  

If, however, you wish to delete clients/partners and specific data individually, then this can be carried 

out within the Data Entry Design option, or List View by using the Delete button as shown below. 
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Whenever a deletion is carried out, then a reason should be entered which will then be displayed in 

the deleted clients report. 

 

 

The delete function asks for final confirmation as once the clients are deleted, they cannot be restored.  

Clients can be protected from deletion. This is documented in a separate section below. 
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Deleted client list 
To see a list of deleted clients, select this option from the View menu, as shown. 

 

  

 

Under the GDPR rules, when a client has been deleted, there can be no record kept of any of the client 

data. Therefore, the deleted clients list will only contain a unique Client ID, who deleted the client, 

when and why.  
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A ‘deleted clients’ list can be exported in a .CSV file to another location allowing it to be saved as part 

of the GDPR record keeping process. 

 

 

Protected Clients 
A client can be protected from being deleted. If you have a client who should not be deleted for any 

particular reason, then the check box on the client tab, shown below, allows them to be excluded from 

the Delete Client function. 
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By selecting the Details button, a dialogue box is displayed where a data range and reason can be 

entered to explain why the client is to be protected from deletion. 

 

 

Protected Client List 
Clients that have been protected from deletion can be viewed by accessing the function from the 

View drop down menu. 

 

This displays a list of protected clients, who has ‘protected’ them, date protected, an expiry date and 

the reason for protection when entered. 
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Exporting Clients 
GDPR requires you to be able to export client data in a common standard format so they can transfer 

it to another professional who they wish to do business with. 

To export clients out of the database, select the Export Wizard function under the File menu and follow 

the prompts. 

 



 

MortgageBrain Classic Release Notes v2.2  13 

 

The exporting wizard provides a number of options, as shown below.  

There is the option to select which data and tabs of information you wish to export; whether to export 

for the first applicant and/or second applicant; whether to include data from your own created tabs 

and whether to include any documentation associated with the client/s. 

This information can be exported as a report, if the client wishes to check the data is correct, or in a 

common standard format that can be exported into another database.  
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Backup and Restore 
Backups of the client database should be carried out regularly. These are all date and time stamped 

making it easy to view when a backup was carried out. 

To back up the client database, simply follow the prompts on screen. 

 

Restore Database 
If you need to restore the database at any time, choose a backup from the list of files available. If you 

have carried out any client deletions between the backup and restore dates, then you will need to re-

apply client deletions since the backup date of the restore to be processed. To do this, follow the 

onscreen prompts, as shown below: 
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Debt Calculator 
The debt calculator has been rewritten, offering an easier and clearer user interface to record the 

clients’ debts and investigate if a refinancing solution would be a more viable solution for them. The 

debt calculator can be accessed through the Launch screen of MortgageBrain Classic as shown. 

 

The Debt details tab allows the recording of the clients’ outstanding loans and debts, entering 
amounts, monthly payments, end dates etc. 
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This displays them clearly in a list format and auto calculates the total debt, total interest paid and 
total amount paid if these were to continue. 
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Details for refinancing can be entered into the Refinancing Details tab, recording the new initial and 
reversionary rate, initial rate period and term to calculate the new monthly payments and any monthly 
savings by refinancing. 

There is also the ability to show a payment schedule and graph. 
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Budget Planner 
The budget planner, positioned in the Affordability section of the Sourcing tab has been redesigned 

to make the input of information easier and clearer.  
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The budget planner is split into Income, Outgoings, Future costs and a Summary and will take this 
information through into the Affordability section of sourcing (see the separate user guide on this 
function). 
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GDPR 

The following information has been taken from the ICO (Information Commissioner’s Office) 
website. Further information can be found by clicking on the following link: 

https://ico.org.uk/for-organisations/guide-to-the-general-data-protection-regulation-gdpr/ 

GDPR details the following rights for individuals: 

The right to be informed  
The information you supply about the processing of personal data must be: 

 concise, transparent, intelligible and easily accessible; 
 written in clear and plain language, particularly if addressed to a child; and 
 free of charge. 

These changes focus on the consent recorded by the individual on initial meeting and can be 
recorded in a back office system, such as The Key. 

The right of access  
Under the GDPR, individuals will have the right to obtain: 

 confirmation that their data is being processed; 
 access to their personal data; and 
 other supplementary information – this largely corresponds to the information that should 

be provided in a privacy notice  

The GDPR clarifies that the reason for allowing individuals to access their personal data is so that 
they are aware of and can verify the lawfulness of the processing 

You must provide a copy of the information free of charge. However, you can charge a ‘reasonable 
fee’ when a request is manifestly unfounded or excessive, particularly if it is repetitive. Information 
must be provided without delay and at the latest within one month of receipt.  You should provide 
the information in a commonly used electronic format. 

The right to rectification 

Individuals are entitled to have personal data rectified if it is inaccurate or incomplete. 

If you have disclosed the personal data in question to others, you must contact each recipient and 
inform them of the rectification - unless this proves impossible or involves disproportionate effort. If 
asked to, you must also inform the individuals about these recipients.  

You must respond within one month. This can be extended by two months where the request for 
rectification is complex. 

The right to erasure  
The right to erasure is also known as ‘the right to be forgotten’. 

The broad principle underpinning this right is to enable an individual to request the deletion or 
removal of personal data where there is no compelling reason for its continued processing. 

https://ico.org.uk/for-organisations/guide-to-the-general-data-protection-regulation-gdpr/
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The right to erasure does not provide an absolute ‘right to be forgotten’. Individuals have a right to 
have personal data erased and to prevent processing in specific circumstances: 

 Where the personal data is no longer necessary in relation to the purpose for which it was 
originally collected/processed. 

 When the individual withdraws consent. 
 When the individual objects to the processing and there is no overriding legitimate interest 

for continuing the processing. 
 The personal data was unlawfully processed (i.e. otherwise in breach of the GDPR). 
 The personal data has to be erased in order to comply with a legal obligation. 
 The personal data is processed in relation to the offer of information society services to a 

child. 

Under the GDPR, this right is not limited to processing that causes unwarranted and substantial 
damage or distress. However, if the processing does cause damage or distress, this is likely to make 
the case for erasure stronger. 

There are some specific circumstances where the right to erasure does not apply and you can refuse 
to deal with a request. 

The right to restrict processing  
Individuals have a right to ‘block’ or suppress processing of personal data. 

 When processing is restricted, you are permitted to store the personal data, but not further 
process it. 

 You can retain just enough information about the individual to ensure that the restriction is 
respected in future. 

The right to data portability  

The right to data portability allows individuals to obtain and reuse their personal data for their own 
purposes across different services. 

It allows them to move, copy or transfer personal data easily from one IT environment to 
another in a safe and secure way, without hindrance to usability. 

Some organisations in the UK already offer data portability through the midata and similar 
initiatives which allow individuals to view, access and use their personal consumption and 
transaction data in a way that is portable and safe. 

It enables consumers to take advantage of applications and services which can use this data to 
find them a better deal, or help them understand their spending habits. 

The right to data portability only applies: 

 to personal data an individual has provided to a controller; 
 where the processing is based on the individual’s consent or for the performance of a 

contract; and 
 when processing is carried out by automated means. 
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 You must provide the personal data in a structured, commonly used and machine readable 
form. Open formats include CSV files. Machine readable means that the information is 
structured so that software can extract specific elements of the data. This enables other 
organisations to use the data. 

 The information must be provided free of charge. 
 If the individual requests it, you may be required to transmit the data directly to another 

organisation if this is technically feasible. However, you are not required to adopt or 
maintain processing systems that are technically compatible with other organisations. 

 If the personal data concerns more than one individual, you must consider whether 
providing the information would prejudice the rights of any other individual. 

You must respond without undue delay, and within one month. 

The right to object  

Individuals have the right to object to: 

 processing based on legitimate interests or the performance of a task in the public 
interest/exercise of official authority (including profiling); 

 direct marketing (including profiling); and 
 processing for purposes of scientific/historical research and statistics. 

Rights in relation to automated decision making and profiling. 

Data Breach  

You should have the right procedures in place to detect, report and investigate a personal data 

breach.  

END 

 

 

 

 

 

 

 

 

 


